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Using the machineasa
printer

Using the Brother printer driver

A Printer Driver is software that translates data from the format used
by a computer into the format required by a particular printer, using
a printer command language or page description language.

The latest printer driver is to be downloaded from the Brother Solutions
Center at:

http://solutions.brother.com

Features

This machine offers many features you'll find in a high quality ink jet
printer.

Fast Printing Speed—Using Fast mode, you can print up to 12
pages per minute in full color, and up to 14 pages per minute in black.

Brilliant High Quality Output—Printing at up to 4800 x 1200
optimized dpi on glossy paper gives you highest resolution. (See
Resolution on page S-6 in the User’'s Guide.)

Beautiful Elaborate Output—You can use 2 in 1, Watermark
(Windows® Only) printing, True2Life® technology and other features
to get high quality printouts.

Low Running Cost—Whenever you run out of a particular color ink,
you will only have to replace the cartridge that's empty.
USB—Universal Serial Bus Interface provides fast communication
with your computer.

Straight Paper Path—The machine can print on many types of
paper. Plain paper, inkjet paper, glossy paper, transparencies and
envelopes. Use the appropriate type of paper to avoid paper jams.

@/ For complete information about what kinds of paper to use with
the machine, read Chapter 2 Paper in the User’s Guide.
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Choosing the right type of paper

To get high quality printing using your machine, it's very important to
select the right type of paper. Be sure to read Chapter 2 Paper in the
User’s Guide before you select and purchase paper for the machine.

How to print your original

When the machine receives data from your computer, it begins
printing by picking up paper from the paper tray. The paper tray can
feed many types of paper and envelopes.
From your computer select the Print command.
If your computer is also connected to any other printers, select
Brother FAX-XXXX USB Printer (Where XXXX is your model
name) as your printer driver from the Print or Print Settings
menu in your software application, and then click on OK to begin
printing. (Windows® only)
@/ For Macintosh® users, see Using the Brother printer driver with
Your Apple® Macintosh® (Mac OS® X) on page 3-4.
2 Your computer sends a print command and data to the machine.
The LCD shows Receiving Data.
3 When the machine finishes printing all the data, the LCD shows
the date and time.

@/ You can select the paper size, and orientation in your
application software.

If your application software does not support your custom paper size,
select the next larger paper size.

Then adjust the print area by changing the right and left margins in
your application software.
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Simultaneous printing and faxing

Your machine can print from your computer while sending or receiving
a fax in memory, or while scanning an original into the computer. Fax
sending will not be stopped during PC printing.

However, when the machine is copying or receiving a fax on paper, it
pauses the PC printing operation, and then continues printing when
copying or fax receiving has finished.

Clearing data from the memory

If the LCD shows Data Remains, you can clear the data that is left
in the printer memory by pressing Stop/Exit.

Checking the Print Quality

If you want to check the print quality and find out how to improve it,
See How to improve print quality on page 12-11 in the User’s Guide.
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Printer driver settings
(Windows® only)

@/ For Macintosh® users, see Using the Brother printer driver with

Your Apple® Macintosh® (Mac OS® X) on page 3-4.

You can change the following printer settings when you print from
your computer:

Media Type/Quality (Speed)
Page Layout

Color Matching/Halftone

Color Enhancement (True2Life®)
Scaling

Watermark

Print Date & Time

Quick Print Setup

How to access the printer driver settings

1
2

Select Print from the File menu in your application software.
Select Brother FAX-XXXX USB Printer (Where XXXX is your
model name) as your printer and click Properties. The Printer
dialog box will appear.

@/ m The way you access the printer driver settings depends on

your operating system and software applications.

® The screens shown in this section are from Windows® XP.
The screens on your Computer may vary depending on your
Windows Operating System.

m Descriptions in this chapter are based on the FAX-1920CN.
These descriptions also apply to the other machines.
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Basic tab

N -

B

1-5

& Brother FAX-1920CN USB Printer. Printing Preferences

Basic | Advanced | Support -
e —— -

] | Media Type
1 | Qualty
| |
\ L E
1 1 - f__Figl __________
[ | Paper Size” . Latter Ei
0 L Fage Layout Marmal -
L e .
, L
! Drientation * Porfrait
' ¢ Landscape
* _ Lopies T
S I™ Reyerse Oider

MFC will stop Color/Grayscale print operalipnewhen one or more of h
the ink cartridges are empty. . Default About ~
v

Select the Media Type and Quality.

Select the Paper Size, Page Layout, Border Line (if any),
Orientation, number of Copies and the page order.

Click the Apply button to apply your selected settings.
To return to the default settings, click the Default button, then

click the Apply button.

*This area shows the current settings of Quality, Paper Size,
Page Layout, Orientation, Collate/Reverse Order and

Color/Grayscale.
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Media Type

To achieve the best print results, the media being printed on should
be selected in the driver. The machine changes the way it prints,
depending on the selected media type.

Plain Paper

Inkjet Paper

Glossy Paper (4 color)
Glossy Paper (3 color)
Transparencies

@/ The print quality of black ink depends on the type of glossy
paper you are using. Black ink is used when you select Glossy
Paper (4 color). If the glossy paper you are using repels the
black ink, select Glossy Paper (3 color), which simulates black
ink by combining the three ink colors.

Quality

The quality selection allows you to choose the print resolution you
want for your original. Print quality and speed are related. The higher
the quality the longer it will take to print the original. The quality
selections that are available will vary depending on the media type
you select.

m Photo: Up to 4800 x 1200 optimized dpi. (See Resolution on
page S-6 in the User's Guide.) Use this mode to print precise
images such as photographs. This is the highest resolution and
slowest speed.

m  S.Fine (Super Fine): 1200 x 1200 dpi. Use this mode to print
precise text and photographs. Since the print data is much larger
than normal mode, the processing time, data transfer time and
print time will be longer.

m Fine: 600 x 600 dpi. Better print quality than Normal mode and
faster print speed than Super Fine.
Normal: 600 x 300 dpi. Good print quality with typical print speed.

Fast: 600 x 150 dpi. The fastest print mode and the lowest ink
consumption. Use this mode to print large volume originals or a
original for proofing.
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Media Type Color/Grayscale Print Quality Selection
Plain Paper Color/Grayscale Fast, Normal, Fine, S.Fine
Inkjet Paper Color Fine, S.Fine, Photo
Grayscale Fine, S.Fine, Photo
Glossy Paper (4 or 3 color) | Color S.Fine, Photo
Grayscale S.Fine, Photo
Transparencies Color/Grayscale Fine, S.Fine

@/ The factory settings are shown in bold.

Bi-Directional Printing

When Bi-Directional Printing is selected, the print heads print in
both directions and offer faster print speeds. When not selected, the
print heads will only print in one direction to provide higher quality
printouts.

& Brother FaX-1920CN USB Printer Printing Preferences

Basic | Advanced | Support
Media Type Flain Paper -
ABC Quality " S Fine y
e " Fine |
- L] Set
5 Wi & Homd | sting |
= L
Paper Size Letter -
Letter B %5 11 in Page Lapout Narmal -
Orientation =+ Portrait
" Landzcape
LCopies Bi-Directional Printing
pramn |
@ ™ B-Direcional Printing
MFC will stop Color/Grayscale print operations when one or mare of]
the ink cartridges are emply.
E
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Paper Size

The Paper Size selection provides a large selection of standard
paper sizes. If you wish, you can create a custom size ranging from
3.5"x 4" (88.9 x 101.6 mm) to 8.5" x 14" (215.9 x 355.6 mm). From
the drop-down box, select the Paper Size you are using.

Paper Size I Letter j

You can enter custom size by selecting User Defined. Select the
proper paper thickness to improve the quality of your output.

Custom Paper Size Name
| =
Width [35 a5 ] 85
Height [40 140 ] o
Unit " mm (@ inch
Paper Thickness
Regular j
QK Cancel | Help |

Page Layout

The Page Layout selection can reduce the image size of a page

allowing multiple pages to be printed on one sheet of paper or

enlarging the image size for printing one page on multiple sheets of

paper.

@/ If you are using Windows® 98/98SE/Me, the 4 in 1 layout is not
available.

Border Line

When printing multiple pages on one sheet with the Page Layout
feature, you can choose to have a solid border, dashed border or no
border around each page on the sheet.

Pagelovot K -

Border Line |N0ne ﬂ
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Orientation

Orientation selects the position of how your original will be printed
(Portrait or Landscape).

Orientation ® Portrait

(" Landscape

Portrait (Vertical) Landscape (Horizontal)

ABC==
e

Copies

The Copies selection sets the number of copies that will be printed
(1 to 999).

Collate

With the Collate check box selected, one complete copy of your
original will be printed and then repeated for the number of copies
you selected. If the Collate check box is not selected, then each
page will be printed for all the copies selected before the next page
of the original is printed.

[d@h.z
12

Reverse Order
Reverse Order prints the pages of your original in the opposite order.

Copies 3 EI [ Collate

|
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Advanced tab

1 2 3 4

& Brother FA¥-1320CH USB Printer Printing Preferences

At ColoGragsedle & Color
 Grayscale
_— Image Type *+ Auto
F"‘  Bhato
h ® Erplies

" Custom

I Color Enhancement (True2Life]

MFC will stop Color/Grayscale print opsrations when one or more of
the ink cartridges are smpty. Default

[ ok J[ coancel J[ gppk | [ Hen |

@/ To return to the default settings, click the Default button.

Change the tab settings by selecting one of the following icons:
1.Color

2.Scaling

3.Watermark

4.Device Options
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Color

Color/Grayscale

This selection allows a color original to be printed in black and white
using gray scale.

Color/Grayscale (@ Color

(" Grayscale

Image Type

The printer driver will select the most suitable color matching and half
tone method, depending on your image type. Generally, text and
business graphics are printed vividly and photographic images are
printed softly.

Auto: The printer driver automatically selects the image type.
Photo: Select this mode for photographic images.

Graphics: Select this mode for originals that contain text or
business graphics (charts or clip art).

Custom: If you want to select the color matching and halftone
method, manually select this mode.

Image Type (& Auto
(" Photo
(" Graphics

(" Custom
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Custom Image Type

You can select the color matching method manually. Select the best

one for your original.

& BrotherFAX-1920CN USB Printer Printing Preferences E|E|

Basic | Advanced | §upport

e

Custom

Color/Grayscale

Image Type

" Color

" Grayseale

" Auto
" Phato
" Graphics

& Lud

Selting | |

jg Custom Image Type

Color Matching

the ink. cartridges are empty.

MFC wil stap Color/Grayscale print oper

13

Match Monitor

Color is adjusted to get the closest color match to the PC monitor.
Natural: Suitable for photographic images. The color is adjusted

Halttone Pattern

T

[ Match Monitor

@ MNatural

" Wivid

@ Diffusion

(" Dither

Cancel Default

to print a more natural color.

Vivid: Suitable for business graphics such as charts, graphics

and text. The color is adjusted to give more vivid color.
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Halftone Pattern

The machine can use two methods (Diffusion or Dither) to arrange
where to place dots to express halftones. There are some predefined
patterns set for this and you can select which one to use for your
original. Select the appropriate method.

m Diffusion: Dots are placed at random to create the halftones.
This method of printing is more suitable for printing photographs
that have delicate shades and graphics.

m Dither: Dots are arranged in a pre-defined pattern to make
halftones. This type of printing is more suitable to printing
graphics that have definite color boundaries or for printing charts
such as business charts.

@/ Some halftone settings cannot be selected with certain
combinations of Media Type and Quality selections.
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Color Enhancement (True2Life®)

Selecting Color Enhancement (True2Life®) enables the
True2Life® feature. This feature analyzes your image to improve
quality sharpness, white balance and color density. This process
may take several minutes depending on the size of the image and
the specifications of your computer.

& BrotherFAX-1920CN USB Printer Printing Preferences @El

Basic | Advanced | Support

GSEEIE

Auto Color/Grayscale + Colar

" Grapscale

— Image Type & St
!" " Phato
h " Graphics
" Custom
|W Color Enhancement (True2L fe] | | Selting | |
Color Enhancement @
MFC will stop Color/Gray| Color Density 0 7 b=
the ink cartridges are emyl f \White Balance 0
. =
[~ Auto Image Enhance
-20 0 +20
Brightness 0« ) |
Contrast o O
-20 0 +20
Pied o [ PR
Green o e |
Blue o IR0 = |
oK Cancel Detault Help

m Color Density
This setting adjusts the total amount of color in the image. You
can increase or decrease the amount of color in an image to
improve a washed out or weak picture.

m  White Balance
This setting adjusts the hue of the white areas of an image.
Lighting, camera settings and other influences will effect the
appearance of white. The white areas of a picture may be slightly
pink, yellow or some other color. By using this adjustment you can
correct this effect and bring the white areas back to pure white.
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m  Sharpness
This setting enhances the detail of an image. It is similar to adjusting
the fine focus on a camera. If the image is not in true focus and you
can not see the fine details of the picture, then adjust the sharpness.

m  Auto Image Enhance
Allows individual adjustment of picture settings to improve the
printed image and analyzes data from surrounding or
neighboring pixels in the original.

m Brightness
This setting adjusts the brightness of the whole image. To lighten
or darken the image move the scroll bar to the left or right.

m Contrast
This setting adjusts the contrast of an image. This will make
darker areas darker and lighter areas lighter. Increase the
contrast when you want an image to be clearer. Decrease the
contrast when you want an image to be more subdued.

® Red
Increases the intensity of the Red color to make the image more
red.

m Green
Increase the intensity of the Green color to make the image
greener.

m Blue
Increase the intensity of the Blue color to make the image bluer.
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Scaling

You can change the print size of your original with the Scaling
feature.

& Brother FAX-1920CN USB Printer Printing Preferences E|g|

Basic | Advanced | Support

Scaling (2]

Letter Scaling
8¥xllin & o

" Fit to Paper Size

A " Free [25-100 %]

I Mimar Print
MFC will stop Color/Grayscale print operations wher one or more of
the ink. cartridges are empty. Defalt
[ o J[ coneel J[ feb J[ Heb |

m  Check Off if you want to print the original as it appears on your
screen.

m Check Fit to Paper Size, if your original has an unusual size, or
if you have only the standard size paper.

Check Free if you want to reduce the size.
Check Mirror Print to reverse the data from left to right.
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Watermark

You can place a logo or text into your original as a Watermark. You
can select one of the preset Watermarks, or you can use a bitmap
file or text file that you have created.

Check Use Watermark, and then select the watermark you want to
use.

& Brother FAX-1320CN USB Printer Printing Preferences
Basic | Advanced | Support
B a1 =
Wat k (3]
™ Use Watermark F
Letter
8%u11in Select Watermark r
[
B e
Custom Page Setting
Page Title
Frint Watermark. 4
Page Title 4
MFC will stop Color/Grayscale print operations when one or mare of
the ink cartridges are empty, Default

In background

Check In background with the Watermark to print the watermark
image in the background of your original. If this feature is not
checked then the Watermark will be printed on top of your original.
In Outline Text (Windows® 2000 Professional/XP Only)
Check In Outline Text if you only want to print an outline of the watermark.

Print Watermark

The Print Watermark feature offers the following print choices:
On all pages

On first page only

From second page

Custom
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Watermark Style

You can change the Watermark’s size and position on the page by
selecting the Watermark, and clicking the Edit button. If you want to
add a new Watermark, click the New button, and then select Text or
Bitmap in the Watermark Style.

Watermark Setting
Tile [conFIDENTIAL =]
i Watermark Stle @ Text
o  Bimes
P\
: e& Watermark Text
= ((\Qg/ it Text ‘CONF\DENTIAL
CJO‘\ Font [aviel =]
; toa ] s [Remir =
Color -
Pasiton Watermark Bitmap
[~ futomatically centerect ‘
x [0 El
N EEE
Angle %5 E
oK Cencal Help ‘

m Title

You can select the CONFIDENTIAL, COPY or DRAFT as the
standard title or enter a title you like in the field.

m  Watermark Text
Enter your Watermark text into the Text Box, and then select the
Font, Size, Color and Style.

m  Watermark Bitmap
Enter the file name and location of your bitmap image in the File
box, or Browse for the file location. You can also set the scaling
size of the image.

m Position
This setting offers you the control for where the Watermark is to
be positioned on the page.
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Device Options

Lets you set the following Printer Functions:

Advanced | Support

FEE

Printer Function
Date & Time

Quick Print Setup

I Print Date & Time

J T

IMFC wil stop Color/Girayscale piint operations when ane of more of
the ink: cartridges are empty. Defaul

ok ) [ ceneal [ Heb ]

Print Date & Time

When enabled the Print Date and Time feature will print the date
and time on your original from your computer’s system clock.

Date & Time @

Format
Date | Tue,16 Apr 2002 i
Time 19:43:43 ~

Position
C Left € Center @ Right

Date & Time

C Top @ Bottom

Background
® Transparent
 Opague

oK | C | Defoutt |

Click the Setting button to change the Date and Time format, and
the Position and the Font. To include a background with the Date
and Time, select Opaque. When Opaque is selected, you can click
on the Color button to change the color of the Date and Time
background.

The Date and Time in the selection box shows the format that will
be printed. The actual Date and Time printed on your original is
automatically retrieved from the settings of your computer.
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Quick Print Setup

& Brother FAX-1920CN USB Printer Printing Preferences

Basic | Advanced | Support
EEEES
Printer Function
Print Date & Time Quick Print Setup
« O
" On
=
=
MFC will stap Calor/Grayscale print operations when ane ar more of
the ink. cartridaes are empty. Default
[ ok [ cancel |[ fepk |[ Hep |

The Quick Print Setup feature allows you to quickly select driver
settings. To view settings, simply click your mouse button on the task
tray icon. This feature can be set to ON or OFF from the Device
Options.

Color fGrayscale <OFF= »
out <! R v Mormal

2inl
Dgfault AN
Frinter Property 1in 2x2
Display Toolbar 1in 3x3
About

Exit
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Support tab

The Support Tab provides driver version and setting information. In
addition there are links to the Brother Solutions Center and the
Driver Update Web sites.

Click the Support tab to display the following screen:

& Brother FAX-1920CN USB Printer Printing Preferences

Basic | Advanced | Suppart

Finter Driver @
m Brather Solutions Center

FAX-1920CN USB Printer Connect directly to the Brother Solutions Center
Web [solutions. brother. com] site for up to date
infarmation on device drivers, user guides, white

Version 5.00 for Wirdows 2000 papers and other documentation available for pour
Brather product.

16 May 2003

®© Brother Industries Ltd, 1993 - 2003

All rights Reserved )
LCheck Setting

0k [ Cancel | [ feb [ Hee

Brother Solutions Center

The Brother Solutions Center is a Web site offering information
about your Brother product including FAQs (Frequently Asked
Questions), User Guides, Driver Updates and Tips for using your
machine.

Web Update

Web Update checks the Brother web site for updated drivers, and
automatically downloads and updates the printer driver on your
computer.

Check Setting

The Check Setting selection displays a list of your current driver
settings.
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Using Brother PC-FAX
softwar e (For Windows®)

@/ To use this feature, you can download the software from the
Brother Solutions Center at:

http://solutions.brother.com

@/ For Network connected users with FAX-1920CN, please see
Additional Information for Network PC-FAX users with
FAX-1920CN on page 2-18.

PC-FAX sending

The Brother PC-FAX software lets you send a file from your PC.

You can create a file in any application on your PC, and then send it
as a PC-FAX. You can even attach a cover page note.

All you have to do is set up the receiving parties as Members or
Groups in your PC-FAX Address Book. Then you can use the
Address Book Search feature to quickly find them to address your
fax.

m PC-FAX s available in Black & White only.

® If you are using Windows® XP or Windows® 2000
Professional, you must log on with administrator rights.
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Setting up user information

@/ You can access the User Information from the FAX Sending
dialog box by clicking [l .
(See Sending a file as a PC-FAX using the Facsimile style user
interface on page 2-16.)

Brother PC-FAX Setup X

I Sending ] Speed Dial (Facsimile style only] ]

Mame: [Jahn Doe

LCompany: |Intemat\nnal Spring Board Assoc:

LDepaitment; |U55

Phone Number:  [908-555-1212

Fax Mumber: |908-565-1212
E-mail |JDoe springboad.org
Address 1: [123 Rose Hill Diiver
Addiess 2 |F‘otsvi||e, MJ 08885

Cancel

1 From the Start menu, select Programs, Brother,
MFL-Pro Suite FAX-XXXX (Where XXXX is your model name),
and then select PC-FAX Setup.
The Brother PC-FAX Setup dialog box will appear:

2 You must enter this information to create the Fax Header and
Cover Page.

3 Click OK to save the User Information.
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Sending setup

From the Brother PC-FAX Setup dialog box, click the Sending tab
to display the screen below.

Brother PC-FAX Setup 3]

User Information  Sending l Speed Dial [Faczimile style only] ]

Dial Setting
Outside line access:

Header Metwork PC-Féx
¥ Include header g ;

| |

The location of the address book can be changed from the PC-FAx Setup window.
This can be accessed from the main PC-FAx transmission screen.

Uszer interface
" Simple style

+ Facsimile style

(] 8 | Cancel |

The include header option sends an additional page of information
along with fax or E-mail data which contains user and subject
information.

The user has the choice of two user interfaces: Simple style or
Facsimile style. To change the user interface select the interface
setting you want: Simple style or Facsimile style.
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Outside line access

If you need to enter a number to access an outside line, enter it here.
This is sometimes required by a local PBX telephone system (for
example, if you must dial 9, to get an outside line in your office).

Include header

To add header information to the top of the fax pages you send,
check the Include header box.

Address Book file

To select you must enter the path and file name of the database file
which contains the address book information.

_OR_
Use the Browse button to find the database to select.
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User interface

In the Sending tab, select user interface you wish to use.
You can choose the Simple Style or the Facsimile Style.

Simple style
# . Brother PC-FAX

B el

| Coverpage On g

T |
Clear

Facsimile style

brother

& cover Page on (P)

Speed Dlal
[ 450

. Pause () . Redial (R)
. Clear (L) . Address Book

(1 )(2)(3) 04050
080
200
-« Jo J{ + i@

Stop (X) r— Start (0)
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Speed-Dial setup

From the Brother PC-FAX Setup dialog box, click the Speed-Dial
tab. (To use this feature you must select the Facsimile Style user
interface.)

Brather PC-FAX Setup PR
User Information ] Sending  Speed Dial (Facsimilz style only) ]
Address Book Speed Dial
Narne Fax Ma. Marme Fax
8 5 ales 31 John Raller a08-704-2
3 Jahn Roller 908-704-231 2 Joesmih 908-555-"
13 Joe Smith 908555123 3 Sales
[+«
[1s
s
[]7
[1s
[1s
[ o
< > < >
ak Cancel

You can register a Member or Group on each of the ten Speed-Dial
buttons.

To register an address in a Speed-Dial button:
1 Click the Speed-Dial button you want to program.

2 Click the Member or Group you want to store on the Speed-Dial
button.

3 Click Add >> to save it.
To clear a Speed-Dial button:

1 cClick the Speed-Dial button you want to clear.
2 Click Clear to erase it.
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The Address Book

From the Start menu, select Programs, Brother,
MFL-Pro Suite FAX-XXXX (Where XXXX is your model name), and
then click PC-FAX Address Book.

The Brother Address Book dialog box will appear:

“®] Brother Address Book |Z”Elg|
File Edit Help
[ & W
Mame | Fax E-Mail
@Sales
E Joe Smith 908-555-1234
B} 10hn Roller 905-704-2312
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Setting up a Member in the Address Book

In the Brother Address Book dialog box you can add, edit and
delete stored information of Members and Groups.

1 Inthe Address Book dialog box, click the ] icon to add a

Member.
The Brother Address Book Member Setup dialog box will
appear:
Hame: 3 [soesmin Title: e
Company: |B|nthe| Interational Cop.
Department: Sales Job Title: ’W
Sthrest Address: |1 00 Some Street
Lty ’7 State/Province: ’N.Ji
Zip Code/Post Cade: ’W Country/Regian ’Ll&&i
Business Phone: 908-555-1234 Home Phane: ’7
Eax 508-555-1234 Mabile Phone: —
E-ail: |\Ua.smith@ ***** com
MFC E-Mail Address: |
,Tl Cancel |

2 Inthe Member Setup dialog box, type the Member’s information.
Name is a required field. Click OK to save the information.
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Setting up a Group for Broadcasting

If you often send the same PC-FAX to several recipients, you can
combine them in to a Group.

1 Inthe Brother Address Book dialog box, click the icon to
create a Group.

The Group Setup dialog box appears:

Group Name @ ‘Sa\es‘l

Ayailable Mames

Group Members

John Foller
Joe Smith

>

Add > | <« Hemove |

Ok | Cancel |

Type the name of the new Group in the Group Name field.

In the Available Names box, select each Member to be
included in the Group, and then click Add >>.

Members you add to the Group will be added to the
Group Members box.

4 After all the members you want have been added, click OK.

W
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Editing Member information

1 select the Member or Group you want to edit.
2 Click the edit ] icon.

3 Change the Member or Group information.

4 Click OK to save your changes.

Deleting a Member or Group

1 select the Member or Group you want to delete.
2 Click the delete [ icon.
3 When the Confirm Item Delete dialog box appears, click OK.

Exporting the Address Book

You can export the whole Address Book to an ASCII text file (*.csv).
Orif you wish, you can select and create a Vcard that will be attached
to that Member’s outgoing E-mail. (A Vcard is an electronic business
card that contains the sender’s contact information.)

To export the whole current Address book:
If you are creating a Vcard, you must first select the member.
If you select Vcard in Step 1, Save as type: will be Vcard (*.vcf).
1 From the Address Book select File, point to Export, and then
click Text.
Click Vcard and go to Step 5.

2 From the Available Items column, select the data fields you
wish to Export and then click Add >>.

@/ Select the items in the order you want them listed.
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3 If you are exporting to an ASCI! file, select the Divide Character
- Tab or Comma. This selects between a Tab or Comma to

separate the data fields.
4 select OK to save the data.

Select Items @

Select items in the arder you want them to be listed.
“f'ou can select the separator character to be inserted bebween items.

Available tems Selected ltems

Name ~
Title E

Company

Department Add »>

Job Title

Sheet Address

City 3

State/Province

Zip CodsPost Cods =
Country/Fegion
Business Phone

Divide Character

* Tab

~
e ok | Cancel |

5 Type the name of the file, and then select Save.
@)

Save As

Savein [() My Documents =] £ BB~

|Z)adobe

A |25 Documenti PaperPort:
My Recent [ 5)Eigene PaperPort-Dokumente
Documents | e documents Paperort

fT (Z)Mijn PaperPart-documenten
[E)Mina PaperPort-dalument
Desktap (Z)Mis documentos de PaperPort
My Music
J )My PapetPort Documents
(2Jmy Pictures

My Documents

&£ i@

My Netwok  File pame: ] Save
Places
Cancel

Lef L«

Saveastyper [ Teut flles [".covl
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Importing to the Address Book

You can import ASCII text files (*.csv) or Vcards (electronic business
cards) into your Address Book.

To import an ASCII text file:

1 From the Address Book select File, point to Import, and then
click Text.

—OR—
Click Vcard and go to Step 5.

Select Items ﬁ\

Select the fields from the Available ltems list in the same arder they are listed in the
Irmport text file.
“Y'ou must select the separator character used in the Import test file.

Available Jtems Selected Itemsz

Name
Title

Company

Departrent Add >
Job Title

Shreet Address

City

State/Province

Zip Code/Fost Code << Hemm
Countiy/Region

Buginess Phone

Divide Character
* Tah

~
(Gemmin ok | Cancel |

2 From the Available Items column select the data fields you
want to Import, and click Add >>.

From the Available Items list select the fields in the same order
they are listed in the Import text file.

3 Select the Divide Character - Tab or Comma based on the file
format you are importing.

4 To import the data click OK.
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5 Type the name of the file, and then select Open.
Open @

Look [ () My Documents =l £F Ef-

) () Adobe
53' [C2)Documenti PaperPort

My Recent  [=)Eigene PaperPort-Dokumente
Documents oy v documents PaperPort
@ (C)Mijn PaperPort-documenten

[IMina PaperPort-dokument

Deskiop = Mis ducumentos de PaperPart

My pusic

(IMy PapetPart Documents

[y Pictures

X

My Documents

@

My Camputer

My Network il name [
Places

Open
Cancel

Lol Led

Files of type: [ Teat fles £.t" oo}

@/ If you selected a text file in Step 1, the Files of type: will be
Text file (*.csv).
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Setting up a Cover Page

From the PC-FAX dialog box click [J], to access the PC-Fax Cover
page setup screen.

The Brother PC-FAX Cover Page Setup dialog box will appear:
E Brother PC-FAX Cover Page Setup g‘
[¥ Cowerpage On

Ta Comment Clear

Name ‘Taru MNagoya

Department Sales
Company Brother Intemational Corp

Fram

Form

MName John Doe

& Typel " Type2
TEL 123-456-789
FAx 987-654-321 [ Import BMP file Browse.
EMail sbc@defghi File name Cvrpage.bmp
Department Marketing Alignment @ Left

(~ Center

Campary Brother Industies, LTD.  Pight
Address] 123 Rose Hill Oriver " Wallpaper

Address? Potsville, MJ UBEEE\ [v Countcover page
Preview, ‘ Default ‘ [0]4 Cancel
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Entering Coverpage Information

@/ If you are sending a fax to more than one recipient, the recipient
information will not be printed on the Cover Page.

To

From

Comment

Type the comment you want to add to the cover page.

Form

Select the cover page format you want to use.

Import BMP file

You can insert a bitmap file, such as your company logo, in the cover

page.

Use the browse button to select the BMP file, and then select the

alignment style.

Count cover page

When the Count Cover Page box is checked, the Cover Page will be
included in the page numbering. When this box is not checked, the
Cover Page will not be included.
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Sending a file as a PC-FAX using the Facsimile
style user interface

1 createafilein Word, Excel, Paint, Draw or any other application
on your PC.

2 From the File menu, select Print.
The Print dialog box will appear:

General

Select Printar

2] add Printer 2 PaperPort Calor
C-500 UISE Printer 23 PaperPort

-FAx

Stsus  Ready O Pintto e

Location:

Comment: Fing Printer...

Page Range

®u Number o copies: (1% |
Selection Cunent Page

O Pages: 1-65535 Collate ! E

Enter either a single page number or a single @

page range. For example, 5-1

[ e J[ Cancel | [ peby |

3 Select Brother PC-FAX as your printer, and then click OK.
The Facsimile style user interface will appear, if it does not
check the user interface selection setting as detailed on page
2-3.

brother

ﬁ‘ Cover Page On (P)

Sptid Dial. 5 5 5

BB.....

. Pause {-) . Redial (R)

ﬂ g .[:Iear (W] .nddress Book
48}
BE oo
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4 Enter the fax number using any of the following methods:
m  Using the dial pad enter the number.
m  Click any of the 10 Speed-Dial buttons.

m Click the Address Book button, and then select a Member
or Group from the Address Book.

@/ If you make a mistake click Clear to delete all the entries.

5 Toinclude a Cover Page, click {_j Cover Page On, and then
click the Cover Page icon to enter or edit the Cover Page
information.

6 Click Start to send the fax.
@/ If you want to cancel the fax, click Stop.

Redial
If you want to redial a number, click Redial to scroll through the last
five fax numbers, and then click Start.

Sending afile as a PC-FAX using the Simple style
user interface

1 Create afile in Word, Excel, Paint, Draw or any other application
on your PC.

2 From the File menu, select Print.
The Print dialog box will appear:
& print @El

General

Select Printer

12 Add Printer 2 paperPort Color
2 Brother MFC-§90 USE Printer <2 PaperPart

Staus  Ready [Pt to e
Location:
Comment:
Page Fange
@4 Mumber of copies: |1 &
O Pages 165535
Pl
page range. For example, 5-12

FPrint I[ Cancel ” Apply ]
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3 Select Brother PC-FAX as your printer, and then click OK.

The Simple style user interface will appear, if it does not check
the user interface selection setting as detailed on page 2-3.

| 3| 3| Ld

[+ Caovergage On g

To [
Clear

4 In the To: field, type the fax number of the recipient. You can
also use the Address Book to select destination fax numbers by
clicking the To: button. If you made a mistake entering a
number, click the Clear button to delete all the entries.

5 TosendaCover Page and note, click the Cover Page On check
box.

@/ You can also click the _EL icon to create or edit a cover page.

6 When you are ready to send your fax, click the Send icon.
[ 1f you wish to cancel the fax, click the Cancel i§§ icon.

Additional Information for Network
PC-FAX users with FAX-1920CN

Enable Network PC-FAX

To use the machine with Network PC-FAX, the machine must be

configured with a TCP/IP address. If you use PC-FAX to an E-mail

address, the mail server settings must also be configured.

@/ The items described in this chapter are specific items relating to
the Network version of PC-FAX software.

Brother Network PC-FAX can be configured through the
PC-FAX Setup, Sending tab.
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Using the Brother Network PC-FAX software

The Brother Network PC-FAX feature allows you to use your PC to
send any application or original file as a standard fax. You can create
a file in any application on your PC, and then send it as a Network
PC-FAX. You can even attach a cover page note. All you have to do
is set up the receiving parties as Members or Groups in your Brother
PC-FAX Address Book or simply enter the destination address or fax
number into the User Interface. You can use the Address Book
Search feature to quickly find members to send your fax.

@/ Please check Brother Solutions Center for the latest updates
available for Brother Network PC-FAX. Visit
http://solutions.brother.com/

Quick Tips:

Please see Sending setup (For Network Users) on page 2-20 before
using Brother Network PC-FAX.

1 Ensure that Network PC-FAX is set to “Enable” in the Sending
tab of Setup. (See Sending setup (For Network Users) on page
2-20.)

2 Tosend an E-mail from Brother Network PC-FAX you can either
enter the E-mail address in the To: field or in the display for
Facsimile Style user interface using the PC keyboard or select
the member from the Address Book. The member must have
E-mail selected as the chosen destination for that member.

3 Tosend an Internet Fax from Brother Network PC-FAX you can
either enter the Internet Fax address in the To: field or in the
display for Facsimile style user interface using the PC keyboard
or select the member from the Address Book. The member must
have machine’s Mail Address selected as the chosen
destination for that member.

4 To send a Network Fax simply select a member from the
address book or enter the fax number into the User Interface
with the PC keyboard. The member must have Fax selected as
the chosen destination for that member.

@/ Sending a Network PC-FAX to an E-mail address or sending an
Internet Fax requires SMTP/POP3 mail server support.
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Sending setup (For Network Users)

In order to use the full functionality of Network PC-FAX you must
enable the Network PC-FAX option on the Sending tab of Brother
PC-FAX Setup.

1 Accessthe Sending Tab from the PC-FAX dialog box by clicking
(72
—0OR—
From the Start menu, select All Programs, Brother, MFL-Pro
Suite FAX-1920CN, and then select PC-FAX Setup.

2 Check Enable box.

Brother PC-FAX Setup Px
User Information  Sending ] Speed Dial [Facsimile style onl_u]]
Dial Setting

Dutside line access:

Header
v Include header

MNetwork PC-FAX
I Enable

[

The location of the address book can be changed from the PC-FAY Setup window,
This can be accessed from the main PC-FAX trangmission screen.

User interface
" Simple style

% Facsimile style

Cancel

This software can be used in a network environment and with a
locally connected machine. It is important that when used in a
network environment the Network PC Fax is set to enable.
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Extra options in Address Book (For Network
Users)

When the Enable Network PC-FAX option is selected, three
additional options appear in the address book contact window.

1 Inthe Address Book dialog box, click the [@] icon to add a

member.
The Brother Address Book Member Setup dialog box will
appear:
DName: o Title: [
Company: [
Department. [ lobTite —
Street Address: [
City [ State/Piovince: —
ZpCode/PostCode: | Counliy/Begion: [
Business Phone: [ HomePhone [
Mabile Phane: —
I Eax r
I~ EMail [
[~ MFCE-Mai Address: |
OK. Cancel

2 Inthe Brother Address Book Member Setup dialog box, type
the member’s information.
Name is a required field. You can also enter an E-mail contact
address and machine’s address for the address book member.

3 To send to this contact it is necessary to specify which is the
preferred method of sending an original to this contact by
checking the Fax, E-mail or E-mail Address box next to the
contact.

4 Click the OK button to save the member’s information.

@/ If you wish to send an original to this contact by more than one
method you must create a second contact and select a different
option, Fax, E-Mail or Address.

To use the machine for Network PC-FAX, see Using Brother PC-FAX
software (For Windows®) on page 2-1.
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I Using your machinewith a
Macintosh®

Setting up your USB-equipped Apple®
Macintosh®

@/ Before you can connect the machine to your Macintosh®, you
must buy a USB cable that is not longer than 6 feet (2 metres).
Do not connect the machine to a USB port on akeyboard or
anon-powered USB hub.

The features supported by the machine will depend on the operating
system you are using. The chart below shows which features are
supported.

Feature Mac OS® Mac OS® X
8.6 9.X 10.1 10.2.1 or
greater*!
Printing Yes Yes Yes Yes
PC-FAX sending Yes Yes Yes Yes

*1 For Mac OS® X 10.2 user, please upgrade to Mac OS® X 10.2.1
or greater. (The latest information for Mac OS® X, please visit at:
http://solutions.brother.com)

@/ Descriptions in this chapter are based on the FAX-1920CN.
These descriptions also apply to the other machines.

@/ To use this feature, you can download the printer driver from the
Brother Solutions Center at:

http://solutions.brother.com
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Using the Brother printer driver with
your Apple® Macintosh®
(Mac OS® 8.6-9.2)

To select a Printer:
1 Open the Chooser from the Apple menu.

O=————————————Cooser——————H

- Connect to:
‘ @ | [Fax-1920cn [=]

Erother Ink HL-1440/350/ 70N

Brother Laser

-

Background Printing: @ On (O Off

@ Active
) Inactive 7.6.2

AppleTalk

A U]

2 Click the Brother Ink icon. On the right side of the Chooser
window, click the printer you want to print to. Close the
Chooser.

To print an original:

3 From the application software such as Presto! PageManager®,
click the File menu and select Page Setup. Change the settings
for Paper Size, Paper Thickness, Paper Source, Orientation,
and Scaling and then click OK.

brother Fax-19206N 200
Paper Size: @ Letter O A4 y
O Legal O As

(O Executive 3 [Post card e T
Orientation : b, B Scaling : o __
I

Paper Thickness
Paper Source : Default
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4 From application software such as Presto! PageManager®, click
the File menu and select Print. Click Print to start printing.

brother Fax-19z0cN

Output :
Copies : El
Pages : @& All (3 From: l:l To: l:l
Quality
Media Type : [Plain Paper L
Color/Grayscale : @

Color Grayscale

[ Save Settings ][ Default ]

B

If you want to change Copies, Pages, Quality, Media Type and
Color/Grayscale, select your settings before clicking Print.

Click the Option button to change Document and

Printing Options.

Device Options

Document:

=N

=L iy
B | %D
Photo Graphics Custom

=D

Auto

[ Bi-Directional Printing
Layout: Pages per Sheet

2 H 5
o] [E0] 2T

Border: |None hd
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Using the Brother printer driver with
Your Apple® Macintosh® (Mac OS® X)

Choosing page setup options

1 From application software such as Presto! PageManager®, click
the File menu and select Page Setup. Make sure FAX-XXXX
(Where XXXX is your model name) is selected in the Format for
pop-up menu. You can change the settings for Paper Size,
Orientation and Scaling, then click OK.

Settings: | Page Attributes ?

Format for: | FAX-1920CN =
Brother Ink

Paper Size: | Letter ?1

8.50 in. x 11.00 in.

Orientation:
100 %

Scale:

2 From application software such as Presto! PageManager®, click
File menu and select Print. Click Print to start printing.

Printer: | FAX-1920CN =
Presets: = Standard ?1
= Copies & Pages ?1
: Copies: 1 @Collated
Pages: @ All
O From: |1 to: |1
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Choosing printing options

To control special printing features, choose Print Settings in the
Print dialog box. You can change Quality, Media Type,
Color/Grayscale, Paper Thickness and Bi-Directional Printing
settings.

Printer: | FAX-1920CN

Presets: = Standard

v Copies & Pages
Layout
Output Options fCollated
Color Control :
Send Fax 1 tor |1
Summary

{4 save Custom Setting Preview ) (“Cancel ) € Print )

Printer: | FAX-1920CN

Presets: | Standard

— Print Settings F"J
— Quality -
® Normal Media Type: Plain Paper s
O Fine
O Super Fine
O Photo

Paper Thickness:| Regular 'y

@Bi—DirE(tionai Printing

__ Color/Crayscale
@ Color
O Grayscale

@ { Preview ( cancel E

See Resolution on page S-6 in the User’s Guide.
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Sending a fax from your Macintosh®

application
For Mac OS® 8.6 - 9.2 users

You can send a fax directly from a Macintosh® application.

1 Create an original in a Macintosh application.
2 To send a fax, select Print from the File menu.

The Printer dialog box will appear:

brother Fax-192068 200 -
Cron ]
Output :
Copies EI _
Pages: @ All O From: l:l To: l:l
Quality :
Media Type : [Prain Paper |
Color/Grayscale : @
Color Grayscale [ Save Settings ] [ Default ]

When Printer is selected, the top button shows Print and the

Address button is grayed.

3 From the Output pull-down menu, select Facsimile.

brother Fax-19206K 200
<[ outout:

Copigs>~ - -----~---~ ... ——
Pages: @ All 2 From: l:l To: l:l
Quality :
Media Type : [P1ain Paper |
Color/Grayscale : @

Color Grayscale [ Save Settings ] [ Default ]

When Facsimile is selected, the top button changes to Send
Fax and the Address button will be available.
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4 Click Send Fax.
The Send Fax dialog box appears:

Send Fax

Input Fax Number : Destination Fax Numbers :
Stored Fax Numbers : [I]

Barbara 908-477-8888| E]

Bob 908-869-8888
Frank 908-236-8388
Tony 908-569-8888

New ][ Group ][ Edit ][ Delete ][ Save ] [ Cancel ]” Send Fax ]I

The Send Fax dialog box has two list boxes. The left box shows
all the previously Stored Fax Numbers and the right box shows
the Destination Fax Numbers as you select them.

5 Toaddress the fax, type a fax number in the Input Fax Number
box.

6 When you are finished addressing your fax, click Send Fax.

@/ To select and only send certain pages of the original, click OK
to go to the Print dialog box.

@/ If you click Send Fax without addressing your fax, the following
error message will appear:

No fax number is selected!
& Click OK to continue, and then select the

Destination Fax Numbers.

Click OK to go to the Send Fax dialog box.

Sending a Network PC-FAX from your Macintosh®
application (FAX-1920CN only)

You can send a fax directly from your Macintosh® application using
the following steps:

1 Please download the software from the Brother Solutions Center
at: http://solutions.brother.com

2 Follow the steps on pages 3-6.
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For Mac OS® X users

You can send a fax directly from a Macintosh® application.

1 create an original in a Macintosh application.
2 To send a fax, select Print from the File menu.
The Printer dialog box will appear:

Printer: | FAX-1920CN =
Presets: | Standard a
\ Copies & Pages a
Copies: ([ | @Collated
Pages: @ All
O From: |1 to: 1
@ { Preview { cancel @
3 Select Send Fax from the pull-down menu.
Printer: | FAX-1920CN =
Presets: | Standard a
v Copies & Pages
Layout
Output Options [ Collated
Print Settings
Color Control 1 —n
=
Summary
ﬁ Save Custom Setting Preview ) { Cancel ) E
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4 Select Facsimile from the Output pull-down menu.

printer: | FAX-1920CN )
Presets: | Standard a
— Send Fax !
Output Facsimile I :}
Input Fax Number :
 Add
Stored Fax Numbers
{ Address Book )
Destination Fax Numbers :
| Name | Fax#
€ e ] R
Delete
"?-\ Preview { Cancel f Print ,

5 Toaddress the fax, type a fax number in the Input Fax Number
box, and the click Print.

@/ If you want to send a fax to more than one number, click Add
after entering the first fax number. The destination fax numbers
will be listed in the dialog box.

Printer: [ FAX-1920CN 3]
Presets: | Standard a
| Send Fax !
Output Printer s
Input Fax Number
Add
Stored Fax Numbers :
Address Book
Destination Fax Numbers
Name Faxf
Bob 999-888-0000
C
Delete
/‘f’\ Preview f cancel ( Print ,
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Drag a vCard from the Mac OS® X Address Book
application

You can address the fax number using a vCard (an electronic

business card) from Mac OS® application to the destination fax
number field.

1 click Address Book button.

2 Drag a vCard from the Mac OS® X Address Book application
to the Destination Fax Numbers filed.

When you are finished addressing your fax, click Print.

MFC-3220C

000 Address Book
| = AEE——
Output : Facimile = | [:D (=) Search:
Group Name
A [ | Barble Bob ‘
1 | @ Directories |
Stored Fax Numbers | | I ‘
| ] work 999-888-0001
- | | work fax 999-888-0000
| i work bob@xxx. ‘
‘ \
| |
= (CEdic) Ql0!

Delete

Output
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@/ The vCard used must contain a work fax or home fax number.

@/ When you choose work fax or home fax from the Stored Fax
Numbers pull-down list, only the fax number stored in the
Mac OS® X Address Book for the selected category will be
used. If the fax number is stored in only one of the Mac OS® X
Address Book categories, the number will be retrieved no matter
which category you have selected (work or home).

Sending a Network PC-FAX from your Macintosh®
application (FAX-1920CN only)

You can send a fax directly from your Macintosh® application using
the following steps:
1 Please download the software from the Brother Solutions Center
at: http://solutions.brother.com

2 Follow the steps on page 3-8.
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1 Brother Network PC-FAX
software (For FAX-1920CN

only)

Enable Network PC-FAX

To use the machine with Network PC-FAX, the machine must be

configured with a TCP/IP address. If you use PC-FAX to an E-mail

address, the mail server settings must also be configured.

@/ The items described in this chapter are specific items relating to
the Network version of PC-FAX software.

Brother Network PC-FAX can be configured through PC-FAX
Setup, Sending tab.
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Sending setup

In order to use the full functionality of Network PC-FAX it is strongly
recommended that you enable the Network PC-FAX Setup option on
the Sending tab Brother PC-FAX Setup.

1 Access the Sending Tab from the PC-FAX dialog box by clicking
iz
—OR—
From the Start menu, select All Programs, Brother, MFL-Pro
Suite FAX-1920CN, and then select PC-FAX Setup.

2 Check Enable box.

User Information  Sending ] Speed Dial [Facsimile style only]]

Dial Setting
Dutside line access:

Header
¥ Include header

Network PC-Fax
W Enabls

| |

The location of the address book can be changed from the PC-FAX Setup window:
This can be accessed from the main PC-FAX transmission screen

User interface
" Simple style

¥ Facsimile style

This software can be used in a network environment and with a
locally connected machine. It is important that when used in a
network environment the Network PC Fax is set to enable.
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Extra options in Address Book

When the Enable Network PC-FAX option is selected, three
additional options appear in the address book contact window.

1 Inthe Address Book dialog box, click the [g] icon to add a

member.
The Brother Address Book Member Setup dialog box will
appear:
DName: o Title: [
Company: [
Department. [ lobTite —
Street Address: [
City [ State/Piovince: —
ZpCode/PostCode: | Counly/Begion: [
Business Phone: [ HomePhone —
Mobile Phone: r
I Eax —
[~ EMail [
[~ MFCE-Mal Address: |
0K Cancsl

2 Inthe Brother Address Book Member Setup dialog box, type

the member’s information.

Name is a required field. You can also enter an E-mail contact
address and machine address for the address book member.

3 To send to this contact it is necessary to specify which is the
preferred method of sending an original to this contact by
checking the Fax, E-mail or machine’s E-mail Address box next

to the contact.

4 Click the OK button to save the member’s information.

@/ If you wish to send an original to this contact by more than one
method you must create a second contact and select a different

option, Fax, E-Mail or machine’s Address.

To use the machine for Network PC-FAX, see Using Brother PC-FAX
software (For Windows®) on page 2-1.

BROTHER NETWORK PC-FAX SOFTWARE (FOR FAX-1920CN ONLY) 4-3




Using the Brother Network PC-FAX software

The Brother Network PC-FAX feature allows you to use your PC to
send any application or original file as a standard fax. You can create
a file in any application on your PC, and then send it as a Network
PC-FAX. You can even attach a cover page note. All you have to do
is set up the receiving parties as Members or Groups in your PC-FAX
Address Book or simply enter the destination address or fax number
into the User Interface. You can use the Address Book Search
feature to quickly find members to send your fax.

@/ Please check Brother Solutions Center for the latest updates
available for Brother Network PC-FAX. Visit
http://solutions.brother.com/

Quick Tips:

Please see Sending setup on page 4-2 before using Brother Network
PC-FAX.

1 Ensure that Network PC-FAX is set to “Enable” in the Sending
tab of Setup. (See Sending setup on page 4-2.)

2 To send an E-mail from Brother Network PC-FAX you can either
enter the E-mail address in the To: field or in the display for
Facsimile Style using the PC keyboard or select the member
from the Address Book. The member must have E-mail selected
as the chosen destination for that member.

3 To send an Internet Fax from Brother Network PC-FAX you can
either enter the Internet Fax address in the To: field or in the
display for Facsimile style using the PC keyboard or select the
member from the Address Book. The member must have
machine’s Mail Address selected as the chosen destination for
that member.

4 To send a Network Fax simply select a member from the
address book or enter the fax number into the User Interface
with the PC keyboard. The member must have Fax selected as
the chosen destination for that member.

@/ Sending a Network PC-FAX to an E-mail address or sending an
Internet Fax requires SMTP/POP3 mail server support.
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Sending a Network PC-FAX from your Macintosh®
application

You can send a fax directly from your Macintosh® application using
the following steps:

For Mac OS 8.6 - 9.2 users

1 Please download the software from the Brother Solutions Center
at: http://solutions.brother.com

2 Follow the steps on pages 3-6.
For Mac OS X users

1 Please download the software from the Brother Solutions Center
at: http://solutions.brother.com

2 Follow the steps on page 3-8.
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Visit us on the World Wide Web
http://www.brother.com

These machines are made for use in the USA and CANADA only. We cannot recommend
using them overseas because it may violate the Telecommunications Regulations of that
country and the power requirements of your multi-function center may not be compatible
with the power available in foreign countries. Using USA or CANADA models overseas is
at your own risk and may void your warranty.
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